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 Introduction 

This document is intended for the operator of the Environmental Sensing Capability (ESC) of the 

Department of the National Defence (DND) Polar Epsilon Project. This document (CDRL-028) describes 

the operator tasks necessary to maintain the proper operations of the ESC. This manual is a tutorial to be 

used in conjunction with the following documents: 

 MODIS Ingestion User Guide 

 SeaDAS MODIS Processing User Guide 

 SeaDAS MODIS Processing User Reference 

 Maintenance Manual 

The maintenance tasks are described in the Maintenance Manual. 

1.1 System Identification 

Each instance of the ESC is geographically separated into two sites. The earth station components of ESC 

are located at the remote site. The operator workstation, and MODIS processing and data storage 

components are installed at a Canadian Forces Base where the MetOC is located and initial analysis of the 

generated oceanographic products by the users occurs. Section 2 provides an overview of the ESC system 

components. 

1.2 Overview of the Document 

This document is divided into five sections: 

 Section 1 defines relations and context for the rest of the document 

 Section 2 shows an overview the ESC System hardware components 

 Section 3 describes the operator’s tasks 

 Section 4 describes the operator console 

 Section 5 describes the troubleshooting performed by the operator 

1.3 Reference Documents 

Table 1-1 presents a list of reference documents (RD-#). The documents are located in the Manuals folder on 

the PE-ESC MODIS DVD. 
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Doc # Title Reference Number, 

File Name, or URL 

Issue Date 

RD-01 System Design Description CDRL-010 1.6 09-08-2016 

RD-02 Maintenance Manual CDRL-027 1.14 12-20-2016 

RD-03 Technical Data Package CDRL-030 1.11 09-08-2016 

RD-04 MODIS Ingestion User Guide MODIS-Ingestion-User-

Guide-2016-09-09-v4.5.pdf 
4.5  09-09-2016 

RD-05 SeaDAS MODIS Processing User 

Guide 

SeaDAS-MODIS-

Processing-User-Guide-

2016-12-20-v4.6.pdf 

4.6 12-20-2016 

RD-06 SeaDAS MODIS Processing User 

Reference 

SeaDAS-MODIS-

Processing-User-Reference-

2016-12-20-v4.4.pdf 

4.4 12-20-2016 

     

RD-10 Problem Reporting for OTRS 

User Guide 

OTRS Quick Guide for 

Customer Interface.pdf 
 07-04-2013 

     

RD-13 Product Sharing Description DND-PE-Product-Sharing-

Description-2016-09-08-

v1.1.pdf 

1.1 09-08-2016 

Table 1-1   Reference Documents 

1.4 Conventions and Symbols 

Throughout this document, the keys pressed by the user are shown between []. The symbol [Ctrl-E] means 

the [E] key is pressed while pressing the key [Ctrl]. The symbol [Space] refers to pressing the space bar. 

If you are requested to enter some value or text, the possible choices will be shown between single quotes. If 

the choice is yours, a placeholder, <my-choice>, is shown. Note that this convention may be used on the 

commands you are requested to execute. 

The commands you are requested to execute are in “Courier New” font when shown on a separate line. 

When they are embedded in the text, they are shown between single quotes and in the text font. 

The following symbols are used throughout this manual: 

 

Y Year. (2002, 2003, …) 

yy Last two digits of the year (02,03, …) 

M Month of the year (01, 02, …, 11, 12) 

D Day of the month (01, 02, …, 30, 31) 

h Hour (01, 02, …, 23) 

m Minute (01, 02, …, 58, 59) 

s Second (01, 02, …, 58, 59) 

ddd Day of year (001, 002, …, 365) 

sid Satellite ID: eam1 for TERRA and epm1 for AQUA. 

prod Product name: L1A, GEO, L1B_1KM, L2_SST, L3D_SST_01KM, etc. 

gpp Geo-physical product: BT_11, sst, chlor_a, par, etc. 
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res Resolution: 01_KM, 02_KM, 04_KM, 09_KM, or 36_KM 

area Name of area of interest (12 characters max.) 

n Number of days in the period (1 or 7) 

ttt Time period in days (001 or 007) 
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 System Overview 

The function of the ESC system is to generate Ocean Color (OC) and Sea Surface Temperature (SST) from 

the Moderate Resolution Imaging Spectroradiometer (MODIS) instrument of the NASA Earth Observing 

System (EOS) satellites Aqua and Terra and to make these products available for export to other systems. 

The MODIS data is available in real-time via the Direct Broadcast (DB) and in a time-delayed fashion via 

the Internet. 

Each instance of ESC is geographically separated into two sites. The earth station components of ESC are 

located at the remote site. The operator workstation and the MODIS processing and data storage components 

are installed at a Canadian Forces Base at which the MetOC is located.  A high level, system block diagram 

of the ES capability is depicted in Figure 2-1. 
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Figure 2-1   ESC System Block Diagram 
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2.1 Remote Site 

The figure below shows a block diagram of the ESC outdoor and indoor components at the remote site with 

connection between the various components including the connection to the base site via the GP-Net Router. 
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Figure 2-2   Remote Site, Hardware Components 
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2.2 Base Site 

The figure below shows a block diagram of the ESC components at the Canadian Forces Base site with 

connection between the various components including the connection to the base site via the GP-Net Router. 
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Figure 2-3   Base Site, Hardware Components 
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2.3 System 9000 

The acquisition of the Aqua/Terra DB is done by the ingest processor, which converts the incoming 

telemetry to level 0 and distributes it to the primary processor. If it fails to distribute to the primary 

processor, the level 0 data is sent to the secondary processor. The processor receiving the level 0 data 

generates level 2 and 3 oceanographic products. The operator, via its workstation, monitors and controls the 

ingestion and the automatic processing. The operator is also responsible for the importation of external level 

0 or 1A data and its processing, as well as the exportation of oceanographic products. The data flow of the 

ESC system is shown in the following figure. 
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Figure 2-4   System Data Flow 

 

The operations shown in the diagram above include scheduling, tracking satellites, ingestion, Level 0 

distribution, MODIS processing, storage to the Network Attached Server (NAS), and shared product 

distribution. These operations are done through the System 9000 software with the exception of the shared 
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product distribution.  Note that System 9000 contains a MODIS processing layer interfacing with the 

SeaDAS processing software obtained from NASA. This layer provides a naming convention to ensure 

unique product names and a storage methodology for easy access to the product on the NAS by both 

processors and the operator workstation. The System 9000 software is divided in four main parts: 

 Scheduling, tracking, ingestion, and Level 0 data distribution 

 MODIS processing 

 Shared product distribution 

 Operator Console 

The scheduling, tracking, ingestion, and distribution are done on the ingest processor located at the remote 

site. These operations are monitored and controlled via an Ingest Virtual Screen (IVS) displayed on the 

operator workstation or any computer on the network via a Virtual Network Computing (VNC) viewer. 

Figure 3-3 depicts a typical IVS. 

The MODIS processing is further divided into automatic and manual processing. The automatic processing 

is done on the primary or backup MODIS processor. The manual processing is done on the operator 

workstation. The processing is controlled and monitored via an operator console, running on the computer 

performing the processing. Figure 3-4 shows the operator console. 

The shared products, generated with either the manual or automatic processing and stored on the NAS, are 

distributed to a Zone Interface Point (ZIP) on the CFWOS firewall with the Product Sharing software.  Refer 

to RD-13 for a description of the Product Sharing software. 
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 Operator’s Tasks 

This section describes the operator’s tasks, which consist mainly of monitoring the ingestion and automatic 

processing, performing the manual processing, and exporting the products. The operator’s tasks can be 

divided in five broad categories: 

 Monitor the ingest server 

 Monitor the Automatic processing 

 Import/Export products 

 Manual Processing 

 Cycling 

 Additional tasks 
 

All these tasks are accomplished from the operator workstation console while logged in as user seadas. If 

you are not user seadas on the console, log off by clicking the “Log Out …” function under the “System” 

menu. In the dialog, click “Log Out” to log out. At the login prompt, enter ‘seadas’.  The GNOME 

Environment starts and the desktop looks as follows: 

 

Figure 3-1   Operator Workstation Desktop 

The top panel shows the desktop menus on the left and a clock on the right. The bottom panels show 4 

workspaces on the right: Workstation, Ingest, Primary, and Backup.  Click on the workspace button to 

display it. 

To edit the workspaces, move the cursor to a workspace on the bottom panel, press the right mouse button, 

and select Preferences.  The dialog allows you increase the number of workspaces and to change their 

names. 
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The figure below shows the launch icons. These icons facilitate the operator’s tasks. 

 

Figure 3-2   Operator Workstation Launch Icons 

It is recommended that the operator performs the tasks on more than one workspace in order to reduce the 

number of windows shown on one workspace. For example, before launching the tasks related to the 

ingestion, click on the Ingest workspace. 

Some tasks are performed via the icons shown in the picture above while other tasks require that you enter a 

command. The commands are entered in a terminal window.  If the command is to be executed on the ingest 

server, primary server, or backup server, double-click the ‘Terminal on Ingest Workstation’, Terminal on 

Primary Processor’, or ‘Terminal on Backup Processor’ respectively to open a remote terminal window. 

If the command is to be executed on the workstation, press the right-mouse button while the cursor is on the 

background to show the quick menu, move to “Open Terminal” and release the button. A terminal window 

appears. The commands are entered in this local terminal window. Note that a command beginning with 

‘ssh’ is entered in the local terminal window. 

The following sub-sections describe the tasks performed by the operator. If the task is launched with an icon, 

the icon will be shown as well as the command executed by the icon. 
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3.1 Monitor the Ingest Server 

The scheduling, tracking, and ingestion are done in the background by the STracker+ program running in an 

Ingest Virtual Display (IVS) on the ingest server.  The IVS is launched at boot time and is viewable using 

vncviewer. The IVS is shown in a Virtual Network Computing (VNC) window titled “VNC: IVS (ins)”. To 

access the IVS double-click on the ‘Ingest Operations’ icon 

 

or enter the following command in a local terminal window: 

ssh –Y modis@ins “vncviewer:2” 

 

Figure 3-3   Ingest Virtual Screen 

When not in use, one can exit the VNC-IVS by clicking the “X” button at the upper right corner of the VNC 

window or one can iconize it with the “-” button at the upper right hand corner of the VNC window. 
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The picture above shows the IVS with its three main components: STracker+, ingest log monitoring, and 

distribution log monitoring and its “Root Menu”. Within the virtual screen, the operator controls the 

scheduling via the STracker+ interface and monitors the ingestion logs and distribution log. 

The “Root Menu” gives the operator access to the ingestion logs, the distribution log and various 

administrative functions such as network interface setting, network time settings, etc. STracker+ has a help 

menu that provides a full description of STracker+. You can also find a full description of the ingestion and 

distribution in document RD-04. 

3.1.1 Ingest Virtual Screen Tasks 

The following is a list of routine tasks which the ESC operator performs in the VNC-IVS window. 

 Accessing the IVS Root Menu 

To access the Root Menu, move the cursor to the background (root window) and press the right mouse 

button. The menu, shown in Figure 3-3 and expanded below, will appear and allow the operator to 

perform various tasks. 

 
Root Menu 
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Shuffle Down 

Refresh 

------------ 

MODIS Menu 

Manage Antenna Database (xantmgr) 

Manage ASAP Database (asapmgr) 

Monitor Sectors Status (xstatus) 

Sun Scan (xscan) 

----------------------------------- 

STracker+ 

View Ingest Logs 

Monitor Ingest Logs 

View Distribution Logs 

Monitor Distribution Logs 

View STracker+ Logs 

Monitor STracker+ Logs 

Data Processing (MODISDP) 

 

Login Menu 

ROOT 

GAE 

MODIS 

Utilities 
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Date/Time: 

Date/Time 

Time Zone 

Network Time Protocol 

Configure: 

Keyboard 

Mouse 

Printer 

Sound Card 

Display 
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Network: 

Configure 

Control 

Druid 

Authentication 

NFS Export 

HTTP 

Samba Server 

Miscellaneous: 

Language 

Logical Volume Manager 

Package Management 

Root Password 

Firewall/Security 

Services 

Users/Groups 

Log Viewer 

Switch mail Agent 

CONSOLE 

XCLOCK 

XLOAD 

GMT 

Window Menu 

XTERM(24x80) 

XTERM(44x80) 

XTERM(24x80),10x20 

---------- 

Restart... 

 Starting the Scheduling/Ingestion (STracker+) 

To start the pass scheduling and the data ingestion, move the cursor to the background (root window) 

and press the right mouse button.  The “Root Menu” appears.  Move to the MODIS menu and select 

“STracker+” to start the data ingestion. 

 Stopping the Scheduling/Ingestion (STracker+) 

To stop the scheduling and the ingestion, select “Main->Quit” in the STracker+ window. 

 Controlling the Scheduling/Ingestion 

Refer to document RD-04 for details on controlling the scheduling and the ingestion. 

 Monitoring the Antenna 

To monitor the antenna, compare the satellites’ angles with the antenna angles while tracking a satellite 

(pass). 

 

The satellite information is displayed in the SAT status window. 

 

If the window is not green, refer to Section 5 for troubleshooting. The next or current satellite is shown. 
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The time (hh:mm:ss) preceded with a “-” indicates the time until the next pass. The time preceded with a 

“+” indicates the elapsed since the beginning of the pass. The pointing angles are displayed only when 

tracking a satellite. 

The antenna angles are displayed in the ANT status panel at all times. 

 

If the window is not green, refer to Section 5 for troubleshooting. The gap between the antenna angles 

and the satellite pointing angles should be less than .1 degree when tracking a satellite. STracker+ 

outputs to its daily log the satellite pointing angles, the antenna angle, and receiver information while 

tracking a pass. This log is useful for post-ingest analysis. 

 Monitoring the Receiver 

STracker+ displays the receiver information in the ACQ status panel at the bottom of STracker+. 

 

If the window shows “See Log Panel”, refer to Section 5 for troubleshooting. The receiver frequency 

will switch between 8160.0 and 8215.0 for Aqua and Terra respectively. The value preceding the letter 

‘V’ is the Voltage Controlled Oscillator (VCO) sweep. This value fluctuates between -100 and 100 while 

searching for a signal. The VCO sweep around the center frequency allows the receiver to lock on a 

signal despite the Doppler shift. The sweep stops when the receiver locks on a signal. The value 

preceding the letter ‘S’ indicate the relative strength of the signal. The difference between the strength 

with the antenna stowed and while tracking a satellite gives an indication of the quality of the signal. The 

value is relative and is different for each installation. When the signal strength is high enough, the 

receiver locks and the ‘LK’ icon turns green. The bit synchronization (BS icon) and frame 

synchronization (FS icon) turn green almost immediately. The bit and frame synchronization may be 

delayed for a few seconds if the signal is noisy. Shortly after the bit and frame sync icons turn green, a 

picture should appear on the Quick View window (Section 3.1.2). 

STracker+ outputs to its daily log the satellite pointing angles, the antenna angle, and receiver 

information while tracking a pass. This log is useful for post-ingest analysis. 

 View/Monitor the Ingest Logs 

Every pass/transmission being ingested produces a capture log file.  The ingest log files are stored in 

satellite directories under /users/modis/job. Each log file is identified by the pass date: 

/users/modis/job/sid/ydhms.l 

The ingest log contains error messages if the pass was not ingested correctly.  

To view an ingest log, move the cursor to the background (root window) and press the right mouse 

button.  The “Root Menu” appears.  Move to the MODIS menu and select “View Ingest Logs”. Once the 

browser appears, select the file you want to view with the function FileOpen. 
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To monitor the ingest log of the pass currently being ingested, move the cursor to the background (root 

window) and press the right mouse button.  The “Root Menu” appears.  Move to the MODIS menu and 

select “Monitor Ingest Logs”. The browser loads the newest ingest log file. Any new ingest log file is 

loaded in the viewing window. The viewing window is updated with new lines added to this log by the 

ingest program. 

By default, IVS automatically starts the monitoring of the ingest logs. This window is shown in 

Figure 3-3 on the right side and partially underneath STracker+. 

 View/Monitor the Distribution Log 

Once a pass/transmission has been acquired, it is converted to level 0 (CCSDS packets) and stored in the 

directory /users/modis/STORAGE/level0. A script l0_dist, running in the background, monitors this 

directory and copies the level0 data to the processors. The script outputs its message to a distribution log 

file 

/users/modis/STORAGE/DLOG 

A message is output every minute showing that script l0_dist is waiting for Level 0 data. For each Level 

0 data, the distribution messages are as follow when using SCP transfer mode: 

Wed Sep 1 15:34:33 PDT 2010 No L0U dataset, sleeping 60 seconds. 

Wed Sep 1 15:35:34 PDT 2010 No L0U dataset, sleeping 60 seconds. 

Wed Sep 1 15:36:35 PDT 2010 No L0U dataset, sleeping 60 seconds. 

Wed Sep 1 15:37:01 PDT 2010 SCPing 20100901152213.eam1.ndx to seadas@ps1 

Wed Sep 1 15:37:01 PDT 2010 SCPing 20100901152213.eam1.l0u to seadas@ps1 

Wed Sep 1 15:37:34 PDT 2010 SCPing done. 

Wed Sep 1 15:37:34 PDT 2010 Sleeping 60 seconds. 

Wed Sep 1 15:38:34 PDT 2010 Removing L0U dataset. 

Wed Sep 1 15:37:34 PDT 2010 Exiting. 

 

Wed Sep 1 15:37:35 PDT 2010 Starting /users/modis/bin/l0_dist. 

The distribution messages are as follow when using FTP transfer mode: 

Thu Aug 5 03:37:03 PDT 2010 No L0U dataset, sleeping 60 seconds. 

Thu Aug 5 03:38:04 PDT 2010 No L0U dataset, sleeping 60 seconds. 

Thu Aug 5 03:39:05 PDT 2010 No L0U dataset, sleeping 60 seconds. 

KERBEROS_V4 rejected as an authentication type 

Thu Aug 5 03:40:06 PDT 2010 FTPing 20100805102907.epm1.l0u 

KERBEROS_V4 rejected as an authentication type 

Thu Aug 5 03:40:18 PDT 2010 20100805102907.epm1.l0u copied to ps1. 

Thu Aug 5 03:40:18 PDT 2010 FTPing 20100805102907.epm1.ndx 

KERBEROS_V4 rejected as an authentication type 

Thu Aug 5 03:40:18 PDT 2010 20100805102907.epm1.ndx copied to ps1. 

Thu Aug 5 03:40:18 PDT 2010 FTPing 20100805102907.epm1.gbd 

KERBEROS_V4 rejected as an authentication type 

Thu Aug 5 03:40:18 PDT 2010 20100805102907.epm1.gbd copied to ps1. 

Thu Aug 5 03:40:18 PDT 2010 Sleeping 60 seconds. 

Thu Aug 5 03:41:18 PDT 2010 Removing L0U dataset 

Thu Aug 5 03:41:18 PDT 2010 Exiting. 

  

Thu Aug 5 03:41:18 PDT 2010 Starting /users/modis/bin/l0_dist. 

To view the distribution log, move the cursor to the background (root window) and press the right mouse 

button.  The “Root Menu” appears.  Move to the MODIS menu and select “View Distribution Log”. 

Once the browser appears, select the file with FileOpen. 
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To monitor the distribution log, move the cursor to the background (root window) and press the right 

mouse button.  The “Root Menu” appears.  Move to the MODIS menu and select “Monitor Distribution 

Log”. The browser loads the distribution log on the viewing window. The viewing window is updated 

with new lines added to this log by script l0_dist. The log shows where the level 0 data is distributed. 

By default, IVS automatically starts the monitoring of the distribution log. This window is shown 

in Figure 3-3 on the left side and partially underneath STracker+. 

3.1.2 Start Quick View 

The command xprogress allows you to monitor a sector while it is being created.  To start xprogress double-

click on the “Quick View” icon 

 

or enter the following command in a local terminal window: 

ssh –Y modis@ins “/users/gae/v4.0/x/xprogress –t modis –c 3500 900 –h 2 –s ch31 -a” 

The program xprogress displays the chosen sector (ch31) in real-time, showing new lines as they are added 

to the sector.  This sector was created in such a way as to contain the infra-red channel 31 for the entire pass 

making it ideal to monitor the reception day and night. You can select any sector in the sectorization 

database. You can also adjust the contrast and the vertical and horizontal resolutions. 

3.1.3 Start FOCUS 9000 

FOCUS 9000 allows you to view the images extracted during the ingestion.  To start FOCUS 9000 double-

click on the “FOCUS 9000” icon 

 

or enter the following command in a local terminal window: 

ssh –Y modis@ins “/users/gae/v4.0/x/vnc-focus 4” 

 

A VNC window appears with a GAE terminal and its FOCUS window.  Refer to the “Global Application 

Executive - FOCUS 9000” manual for details. 

3.2 Start the Operator Console 

The operator console is an interface to the SeaDAS MODIS processing programs.  The SeaDAS MODIS 

processing occurs on three (3) computers; operator workstation, primary processing server, and backup 

processing server.  In order to interface with the processing on a given computer, the operator console must 

run on the given computer. 
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3.2.1 Operator Console on Operator Workstation 

To launch the operator console running on the workstation, double-click on the “SeaDAS Manual 

Operations” icon 

 

or execute the following command in the local terminal window: 

/users/seadas/bin/sds_ops –noauto 

Figure 3-4 shows the operator console main window. 
 

3.2.2 Operator Console on Primary Server 

To launch the operator console running on the primary processing server, double-click on the “SeaDAS 

Primary Operations” icon 

 

or execute the following command in the local terminal window: 

ssh seadas@ps1 “/users/seadas/bin/sds_ops –noman” 

Figure 3-4 shows the operator console main window. 

3.2.3 Operator Console on Backup Server 

To launch the operator console running on the backup processing server, double-click on the “SeaDAS 

Backup Operations” icon 

 

or execute the following command in the local terminal window: 

ssh seadas@ps2 “/users/seadas/bin/sds_ops –noman” 

Figure 3-4 below shows the operator console main window. 
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Figure 3-4   Operator Console 

Refer to Section 4 for a complete description of the operator console. 

3.3 Monitor the Automatic Processing 

The automatic processing generates three categories of processing logs: 

 Automatic Processing Log  /users/seadas/PLOG_auto 

 Automatic Granule Processing Logs /users/seadas/data/auto_gran/YMDhms.sid.log 

 Automatic Temporal Processing Logs /users/seadas/data/auto_time/YMD.log 

The processing log shows a level 0 dataset arriving in the incoming directory, the start and end of the level 

1/2 (granule) processing, and the start and end of the L2B/L3 (temporal) processing. Each granule 

processing output is stored in a specific log tagged to the granule ID. Each temporal processing is stored in 

a specific log tagged to the processed day. 

The monitoring is done via the operator console launched on the primary processing server (Section 3.2.2). 

Note that the primary processing server performs the automatic processing by default. 

On the appropriate operator console you can start the monitoring of the automatic processing by selecting 

one of the following functions under the Logs menu; 

 Automatic Processing  Monitor Automatic Processing Log… 

 Automatic Processing  Monitor Automatic Granule Logs… 
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 Automatic Processing  Monitor Automatic Time Logs… 

For day to day operation, only the first function is needed. Once the automatic processing log indicates that a 

granule has been processed 

Wed Aug  4 05:42:25 2010 - Found L0U dataset 20100804052816.eam1. 

Wed Aug  4 05:42:25 2010 - Processing L0U granule 20100804052816.eam1. 

Wed Aug  4 05:42:25 2010 - Using processing DB file /users/seadas/MODIS/db_prc/auto_proc.db 

Wed Aug  4 05:42:25 2010 - Custom script /users/seadas/data/auto_gran/20100804052816.eam1 generated. 

Wed Aug  4 05:42:25 2010 - Execute custom script /users/seadas/data/auto_gran/20100804052816.eam1 

Wed Aug  4 05:42:25 2010 - Check its log file /users/seadas/data/auto_gran/20100804052816.eam1.log 

Store     : T20100804052816.gran.L0P.{pkt[,crx,gbd]} as MODIS-TL0P-gran-20100804-052816.{pkt[,crx,gbd]} 

Store     : T20100804052816.gran.L1A.{hdf[,gbd,]} as MODIS-TL1A-gran-20100804-052816.{hdf[,gbd,]} 

Store     : T20100804052816.gran.GEO.{hdf[,gbd,]} as MODIS-TGEO-gran-20100804-052816.{hdf[,gbd,]} 

Store     : T20100804052816.gran.L1B_1KM.{hdf[,gbd,]} as MODIS-TL1B_1KM-gran-20100804-052816.{hdf[,gbd,]} 

Store     : T20100804052816.gran.L2_SST.{hdf[,,]} as MODIS-TL2_SST-gran-20100804-052816.{hdf[,,]} 

Store     : T20100804052816.california.L2_SST.{hdf[,,]} as MODIS-TL2_SST-california-20100804-052816.{hdf[,,]} 

Store     : T20100804052816.gran.L2_OCP.{hdf[,,]} as MODIS-TL2_OCP-gran-20100804-052816.{hdf[,,]} 

Store     : T20100804052816.california.L2_OCP.{hdf[,,]} as MODIS-TL2_OCP-california-20100804-052816.{hdf[,,]} 

Wed Aug  4 05:56:16 2010 - Execute do_images to generate exportable L2 images. 

Wed Aug  4 05:56:16 2010 - Check its log file /users/seadas/data/auto_gran/20100804052816.eam1.log 

Wed Aug  4 05:57:10 2010 - Appended '20100804052816.eam1' to MP_DB /users/seadas/DATA/MP_DB/auto_gran.db. 

Wed Aug  4 05:57:10 2010 - Processing granule 20100804052816.eam1 done. 

or a full day’s worth of data has been processed 

Wed Aug  4 05:57:11 2010 - Processing day 20100803. 

Wed Aug  4 05:57:11 2010 - Using processing DB file /users/seadas/MODIS/db_prc/auto_proc.db 

Wed Aug  4 05:57:11 2010 - Custom script /users/seadas/data/auto_time/20100803 generated. 

Wed Aug  4 05:57:11 2010 - Execute custom script /users/seadas/data/auto_time/20100803 

Wed Aug  4 05:57:11 2010 - Check its log file /users/seadas/data/auto_time/20100803.log 

Store     : M20100803000000.gran.L2B_SST_01KM.{hdf[,,]} as MODIS-ML2B_SST_01KM-gran-20100803-000000.{hdf[,,]} 

Store     : M20100803000000.gran.L2B_OCP_01KM.{hdf[,,]} as MODIS-ML2B_OCP_01KM-gran-20100803-000000.{hdf[,,]} 

Store     : M20100803000000.california.L3D_SST_01KM.{hdf[,,]} as MODIS-ML3D_SST_01KM-california-20100803-000000.{hdf[,,]} 

Store     : M20100803000000.california.L3D_OCP_01KM.{hdf[,,]} as MODIS-ML3D_OCP_01KM-california-20100803-000000.{hdf[,,]} 

Store     : M20100803000000.california.L3R_SST_01KM.{hdf[,,]} as MODIS-ML3R_SST_01KM-california-20100803-000000.{hdf[,,]} 

Store     : M20100803000000.california.L3R_OCP_01KM.{hdf[,,]} as MODIS-ML3R_OCP_01KM-california-20100803-000000.{hdf[,,]} 

Wed Aug  4 05:59:38 2010 - Execute do_images to generate exportable L3 images. 

Wed Aug  4 05:59:38 2010 - Check its log file /users/seadas/data/auto_time/20100803.log 

Wed Aug  4 05:59:56 2010 - Appended '20100803' to MP_DB /users/seadas/DATA/MP_DB/auto_time.db. 

Wed Aug  4 05:59:56 2010 - Processing day 20100803 done. 

the operator can view the stored products with the SeaDAS Viewer (Section 3.12) and the exportable images 

with the file browser (Section 3.13). Note the lines beginning with ‘Store   :’ indicating that the products 

have been stored to the NAS. 

3.4 Monitor the Manual Processing 

The manual processing generates three categories of processing logs: 

 Manual Processing Log   /users/seadas/PLOG_man 

 Manual Granule Processing Logs /users/seadas/data/man_gran/YMDhms.sid.log 

 Manual Temporal Processing Logs /users/seadas/data/man_time/YMD.log 

The processing log shows the start and end of the level 1/2 (granule) processing, and the start and end of the 

L2B/L3 (temporal) processing. Each granule processing output is stored in a specific log tagged to the 

granule ID. Each temporal processing is stored in a specific log tagged to the processed day. 

The monitoring is done via the operator console launched on the workstation (Section 3.2.1). Note that the 

operator workstation performs the manual processing by default. 

On the appropriate operator console you can start the monitoring of the manual processing by selecting one 

of the following functions under the Logs menu; 

 Manual Processing  Monitor Manual Processing Log… 

 Manual Processing  Monitor Manual Granule Logs… 

 Manual Processing  Monitor Manual Time Logs… 
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For day to day operation, only the first function is needed. Once the manual processing log indicates that a 

granule has been processed 

Wed Jul  7 23:48:49 2010 - Renaming /tmp/sds_list_file_ToLWtd to sds_list_file_ToLWtd_32545 

Wed Jul  7 23:48:49 2010 - Granule processing of external datasets in file sds_list_file_ToLWtd_32545. 

Wed Jul  7 23:48:49 2010 - Temporal processing of days covered by the datasets. 

Wed Jul  7 23:48:49 2010 - Checking datasets in sds_list_file_ToLWtd_32545. 

Wed Jul  7 23:48:49 2010 -  

Wed Jul  7 23:48:49 2010 - Renaming MOD01.A2010171.0600.005.2010173185056.hdf to local convention. 

Wed Jul  7 23:48:51 2010 - Processing 1A granule 20100620060000.eam1 

Wed Jul  7 23:48:51 2010 - Using processing DB file /users/seadas/MODIS/db_prc/man_proc.db 

Wed Jul  7 23:48:51 2010 - Custom script /users/seadas/data/man_gran/20100620060000.eam1 generated. 

Wed Jul  7 23:48:51 2010 - Execute custom script /users/seadas/data/man_gran/20100620060000.eam1 

Wed Jul  7 23:48:51 2010 - Check its log file /users/seadas/data/man_gran/20100620060000.eam1.log 

Wed Jul  7 23:52:31 2010 - Processing granule 20100620060000.eam1 done. 

or a day has been processed 

Wed Jul  7 23:52:31 2010 - Processing L2 for day 20100620. 

Wed Jul  7 23:52:31 2010 - Using processing DB file /users/seadas/MODIS/db_prc/man_proc.db 

Wed Jul  7 23:52:31 2010 - Custom script /users/seadas/data/man_time/20100620 generated. 

Wed Jul  7 23:52:31 2010 - Execute custom script /users/seadas/data/man_time/20100620 

Wed Jul  7 23:52:31 2010 - Check its log file /users/seadas/data/man_time/20100620.log 

Wed Jul  7 23:53:56 2010 - Processing day 20100620 done. 

the operator can view the local products with the SeaDAS Viewer (Section 3.12). 

3.5 Import Products for Manual Processing 

The importing of external products for manual processing is done via the operator console launched on the 

workstation (Section 3.2.1). Note that the operator workstation does the manual processing. 

On the appropriate operator console you can start ordering products by selecting the following functions 

under the File menu; 

 Order NASA L0/L1A… 

This command will start up the default Web browser, and direct it to the NASA’s LAADS Web Data Order 

Portal.  Select the desired products, time and locations as instructed on the LAADS Web page. After 

completing your order, you will receive an order number via e-mail.  You will need this order number to 

download the actual requested datasets. Refer to Section 4 for details. 

The order may take a few hours to a few days to fulfill.  You will receive a second e-mail informing you the 

order is ready to download.  At this point, you can start downloading the products by selecting the following 

function under the File menu; 

 Download NASA L0/L1A… 

Enter the order number you received via e-mail in the “Order Number:” field.  You may also select a staging 

directory, where the final downloaded data will be stored, but will typically use the default.  Once you are 

ready, click the “Run” button and your download will begin.  A terminal window appears showing the output 

of the download command. Press [Enter] when requested, the output of this command will be displayed in 

the lower pane of the console. 

Once the products are downloaded, you can start processing the products.  The following section describes 

the manual processing of the imported products. 

3.6 Manual Processing of Imported Products 

The manual processing is done via the operator console launched on the workstation (Section 3.2.1). Note 

that the workstation does the manual processing. 
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On the appropriate operator console you can start processing the downloaded products by selecting one of 

the following functions under the Processing menu: 

 Manual  Process External   Process External L0 … 

 Manual  Process External   Process External L1A … 

The following dialog appears. 

 

Select L3 processing or not, the resolution, and the area of interest. You can select all the external datasets with 

the function “Fill with all Datasets” in the Datasets menu or you can add selected datasets to the list with the 

function Add in the Datasets menu. Click Run to process the selected dataset. Refer to Section 4 for details. 

3.7 Manual Processing of Local Level 1 Products 

The manual processing is performed via the operator console launched on the workstation (Section 3.2.1). 

Note that the workstation performs the manual processing. 

On the appropriate operator console you can start processing the local products by selecting one of the 

following functions under the Processing menu: 

 Manual  Process Local   Process Local L0… 

 Manual  Process Local   Process Local L1A… 

 Manual  Process Local   Process Local L1B… 
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The following dialog appears. 

 

Select L3 processing or not, the resolution, and the area of interest. If you wish to process one or more 

consecutive days, enter the start date and the end date of the period and select the function “Fill With 

Datasets Between Start/End Dates…”.in the Datasets menu. You can select all the datasets with the function 

“Fill with all Datasets” in the Datasets menu. Or you can add selected datasets to the list with the function 

Add in the Datasets menu. Click Run to process the selected dataset. Refer to Section 4 for details. 

3.8 Manual Processing of Level 2 Products 

The manual processing is performed via the operator console launched on the workstation (Section 3.2.1). 

Note that the workstation performs the manual processing. 

On the appropriate operator console you can start processing the Level 2 products by selecting one of the 

following functions under the Processing menu: 

 Manual  Process Level 2  L2B/L3 Processing (Local Only)… 

 Manual  Process Level 2  L2B/L3 Processing (Local & Stored)… 

  



 
Environmental Sensing Capability Polar Epsilon 

Operators Manual 
 

 

 
December 20, 2016                                       © Her Majesty the Queen in Right of Canada (2016)                                                 Page 29 of 73 

 

The following dialog appears: 

 

Select the resolution, the area of interest, and the start and dates of the processing period. Click Run to 

process the selected dataset. If you selected the function “L2B/L3 Processing (Local & Stored)…”, the 

global L2 products for the given processing period will be restored to the local storage prior to the 

processing. 

3.9 Import Products and Submit for Automatic Processing 

The importing of external products for automatic processing is done via the operator console launched on the 

primary server (Section 3.2.2). Note that the primary processing server performs the processing by default. 

On the appropriate operator console you can start ordering products by selecting the following functions 

under the File menu; 

 Order NASA L0/L1A… 

This command will start up the default Web browser, and direct it to the NASA’s LAADS Web Data Order 

Portal.  Select the desired products, time and locations as instructed on the LAADS Web page. After 

completing your order, you will receive an order number via e-mail.  You will need this order number to 

download the actual requested datasets. 

Once you have received the order number, you can start downloading the products by selecting the following 

functions under the File menu; 

 Download NASA L0/L1A… 

Enter the order number you received via e-mail in the “Order Number:” field.  You may also select a staging 

directory, where the final downloaded data will be stored, but will typically use the default.  Once you are 

ready, click the “Run” button and your download will begin. A terminal window appears showing the 

progress of the download. Refer to Section 4 for details. 

Once the products are downloaded, you can start processing the products by selecting one of the following 

functions under the Processing menu: 

 Automatic  Submit External L0… 

 Automatic  Submit External L1A… 
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The following dialog appears: 

 

You can select all the external datasets with the function “Fill with all Datasets” in the Datasets menu. Or 

you can add selected datasets to the list with the function Add in the Datasets menu. Click Run to process the 

selected dataset. Refer to Section 4 for details. 

3.10 Archive Level 0 Products 

The archiving of the stored level 0 products is done via the operator console launched on the secondary or 

backup server (Section 3.2.3). 

On the appropriate operator console you can start archiving the level 0 products by selecting the following 

functions under the File menu; 

 Archive Stored L0… 
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The following dialog appears: 

 

Enter the start date and the end date of the L0 data you wish to archive. If selected, the L0 data will be 

deleted from the global storage once the archive is done. Click Run to begin the archive process. A terminal 

window appears. You will be asked to enter a blank tape or the latest primary archive tape. Once you have 

inserted the proper tape and pressed [Enter], the archive will proceed. Once the data has been archived to the 

primary offline storage, you will be asked to enter a blank tape or the latest backup archive tape. Once you 

have inserted the proper tape and pressed [Enter], the archive will proceed. Once the data has been archived 

to the backup offline storage, the stored level 0 will be deleted if you have chosen this option. Once the 

command is done, you will be prompted to press [Enter]. The output of this command will be displayed in 

the lower pane of the console. 

Every time you are prompted to enter a blank tape, the program will indicate its name: PDAnnnnn or 

BDAnnnnn. It is important to label the tape with this information. 

3.11 Restore Level 0 Products 

The archiving of the stored level 0 products is done via the operator console launched on the secondary or 

backup server (Section 3.2.3). 

On the appropriate operator console you can start restoring the level 0 products by selecting the following 

functions under the File menu; 

 Restore Archived L0… 

The following dialog appears: 

 

Enter the start date and the end date of the L0 data you wish to restore. Click Run to begin the archive. A 

terminal window appears. You will be asked to enter the primary or backup archive tape containing the level 
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0 data to restore. Once you have inserted the proper tape and pressed [Enter], the restore will proceed. You 

may be prompted for any additional tapes. Once the command is done, you will be prompted to press 

[Enter]. The output of this command will be displayed in the lower pane of the console. 

3.12 Launch the SeaDAS Viewer 

Viewing the products is done on the workstation with the SeaDAS Viewer. To launch the SeaDAS viewer, 

double-click on the “SeaDAS Viewer” icon 

 

or execute the following command: 

xseadas -em 

The following menus and functions window appears 

 

Additionally, an xseadas output window appears showing the messages output by the viewer. 

 

Note that SeaDAS version 7.3 does not have an IDL viewer. Therefore the IDL viewer from SeaDAS 

version 6.4 is used for both versions. 

The SeaDAS viewer allows the user to load products (Display function) and view them with a consistent 

enhancement and color mappings. The products can also be registered to various map projections. For 

further instructions to the SeaDAS viewer, select Help or refer to the SeaDAS online documentation, which 

can be found locally in the directory: 

/usr/local/seadas/6.4/docs 
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Alternatively, the latest documentation, along with a frequently asked questions (FAQ) page as well as a user 

forum can be found at the SeaDAS Web page: 

http://oceancolor.gsfc.nasa.gov/seadas 

3.13 Exportable Images 

The level 2 and level 3 products generated by the automatic processing are converted to exportable image 

format and stored in the directory 

/users/seadas/Images 

This directory is a link to /nas0/SEADAS/Images. Other than the exportable images stored on the NAS, 

operators can export any image on which they have performed visual operations by using the Save function 

of the SeaDAS viewer. 

3.13.1 Browse and View Exportable Images 

You can browse and display these images with the function “File Browser”. The file browser is launched with 

the following icon located on the top panel 

 

or through the following menu. 

 

 

Once the browser appears, click on the “Images” icon and navigate the exportable images created by the 

automatic processing. 

http://oceancolor.gsfc.nasa.gov/seadas
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Once you are in the sub-directory containing exportable images, double-click on the image you wish to view. 

The following dialog appears. 



 
Environmental Sensing Capability Polar Epsilon 

Operators Manual 
 

 

 
December 20, 2016                                       © Her Majesty the Queen in Right of Canada (2016)                                                 Page 35 of 73 

 

 

Click on Previous or Next to display the adjacent images. Once you are done, close the dialog and navigate to 

another directory. 

3.13.2 Exporting the Images 

The operator can export images and products by copying them to a USB drive, a CD, or a DVD.  

If you are using a USB drive, insert it in one of the USB slots on the workstation. An icon appears on the 

desktop along with a window showing the content of the USB drive. If the USB icon does not appear, double-

click on the “Computer” icon on the desktop to show its content. Next, double-click on the USB icon to 

mount it. A USB icon appears on the desktop. Double-click on this icon to open a window showing its 

content. The exportable images and products can be copied to this window. Once you are finished copying, 

right-click on the USB icon and select “Unmount Volume”. 

If you are using a blank DVD-RW, insert it in the lower of the two drives on the workstation. An icon appears 

on the desktop. Double-click on this icon. A window titled “CD/DVD Creator” appears. The exportable 

images and products can be copied to this window. Once you are finished copying, select “Write to disc”. 

Once the data has been written, click Eject to eject the DVD and click Close to close the window. 

If you are using a formatted DVD-RW, insert it in the lower of the two drives on the workstation. A DVD 

icon appears on the console along with a window showing the content of the DVD. If the DVD icon does not 
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appear, double-click on the “Computer” icon on the desktop to show its content. Next, double-click on the 

DVD icon to mount it. A DVD icon appears on the desktop along with a window showing the content of the 

DVD. In this case, select “CD/DVD Creator” under the Places menu on this window. A window titled 

“CD/DVD Creator” appears. The exportable images and products can be copied to this window. Once you are 

finished copying, select “Write to disc”. If there is data already on the DVD, you will be prompted for 

permission to remove it. Once the data has been written, click Eject to eject the DVD and click Close to close 

the window. 

3.14 Cycling 

This section describes the cycling of the MODIS products, exportable images, ancillary data, and the logs. 

The cycling can be done automatically or manually. The data cycling is also discussed in the MODIS 

Ingestion User Guide (RD-04) and the SeaDAS MODIS Processing User Guide (RD-05). 

3.14.1 Local MODIS Products Cycling 

The MODIS products stored locally are cycled using the script loc_cycle. This script contains a prd_cycle 

command for each data level: GRAN, L2G, and L3. This script can be modified to fit your needs and can be 

executed manually or at regular interval as a cron job on the workstation, the primary processing server, and 

the backup processing server. Refer to document RD-05 for details. 

3.14.2 Global MODIS Products Cycling 

The MODIS products stored globally on the NAS server are cycled using the script glo_cycle. The script 

contains a prd_cycle command for each data level: L0, L1, L2, L2G, and L3. This script can be modified to 

fit your needs and can be executed manually or at regular interval as a cron job on the workstation. Refer to 

document RD-05 for details. 

3.14.3 Exportable Images Cycling 

The exportable images stored on the NAS server are cycled in background by the script img_cycle. The L2 

images are stored as granule and the L3 images are stored by area of interest. The script sends the cycling 

parameters to sd_cycle for the granule and the various area of interest. This script can be modified to fit your 

needs and is executed once on the workstation. At regular intervals, sd_cycle scans the exportable images 

directories and cycles them. Refer to document RD-05 for details. 

3.14.4 Ancillary Data Cycling 

The ancillary data stored on the NAS server is cycled by the script anc_cycle. The ancillary data is stored in 

three directories; atteph, metoz, and oisst.  The script sends the cycling parameters to sd_cycle for these 

three directories. This script can be modified to fit your needs and is executed once on the workstation. At 

regular intervals, sd_cycle scans the ancillary data directories and cycles them. Refer to document RD-05 for 

details. 

3.14.5 Operator Console Log Cycling 

The operator console program outputs its messages to a log file /users/seadas/sds_ops.log. Its size should be 

checked from time to time and the log file cycled as follows: 

 Stop the operator console 

 Edit the file and remove the older messages. Or, rename the file to keep it on-line. 

 Start the operator console. 
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This log should be checked on the operator workstation and the processing servers. Refer to document RD-

05 for details. 

3.14.6 Automatic Processing Log Cycling 

The automatic processing outputs its messages to the file /users/seadas/PLOG_auto on the primary and 

backup processing servers. Its size should be checked from time to time. If it exceeds 100,000 lines, follow 

these steps: 

 Monitor the automatic processing (Section 3.3). Wait until the processing is done. 

 Log in to the processing server and rename PLOG_auto 

 Execute the command 

kill -9 `/users/gae/sbin/get_pid auto_proc` 

 Monitor the automatic processing for start-up messages: 

Fri Aug  6 17:51:09 2010 - ######################################################## 

Fri Aug  6 17:51:09 2010 - 

Fri Aug  6 17:51:09 2010 - Fri Aug  6 17:51:09 2010 - Starting 

/users/seadas/MODIS/bin/auto_proc. 

Fri Aug  6 17:51:09 2010 - 

Fri Aug  6 17:51:09 2010 -    Local storage        : /users/seadas/data 

Fri Aug  6 17:51:09 2010 -    Global storage       : /users/seadas/DATA 

Fri Aug  6 17:51:09 2010 -    Incoming Directory   : /users/seadas/level0 

Fri Aug  6 17:51:09 2010 -    Input trigger (L0U)  : *.l0u 

Fri Aug  6 17:51:09 2010 -                  (PDS)  : *.pds 

Fri Aug  6 17:51:09 2010 -                  (L1A)  : *.l1a 

Fri Aug  6 17:51:09 2010 -             (NASA  L0)  : M{O,Y}D00F.*.00{1,0}.PDS 

Fri Aug  6 17:51:09 2010 -             (NASA  1A)  : M{O,Y}D01.*.hdf 

Fri Aug  6 17:51:09 2010 -    Processing DB        : /users/seadas/MODIS/db_prc/auto_proc.db 

Fri Aug  6 17:51:09 2010 -    Granule Processed DB : /users/seadas/DATA/MP_DB/auto_gran.db 

Fri Aug  6 17:51:09 2010 -    Temporal Processed DB: /users/seadas/DATA/MP_DB/auto_time.db 

Refer to document RD-05 for details. 

3.14.7 Manual Processing Log Cycling 

The manual processing outputs its messages to the file /users/seadas/PLOG_man on the operator 

workstation. Its size should be checked from time to time. If it exceeds 100,000 lines, rename the file to keep 

it on-line or delete it. A new file will be created automatically when processing is initiated by the operator. 

Refer to document RD-05 for details. 

 

3.14.8 Processing Scripts and Logs Cycling 

A script is created to process a granule and its output is stored in a granule processing log. A script is also 

created to process a day (L2B and L3) and its output is stored in a time processing log. These scripts and 

logs are created for the automatic processing and the manual processing and are stored in four (4) 

directories: auto_gran, auto_time, man_gran, and man_time.  The script sal_cycle sends the cycling 

parameters to sd_cycle for these four directories if they exist. This script can be modified to fit your needs 

and is executed once on the workstation, the primary processing server and the backup processing server. At 

regular intervals, sd_cycle scans the scripts and logs directories and cycle them. Refer to document RD-05 

for details. 
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3.14.9 System Alert Log Cycling 

The system alert script sds_ops_system_alert outputs its messages to the file /users/seadas/alert.log on the 

operator workstation. Its size should be checked from time to time. If it exceeds 100,000 lines, rename the 

file to keep it on-line or delete it. A new file will be created automatically when the script runs again. Refer 

to document RD-05 for details. 

3.14.10 Distribution Log Cycling 

The distribution script l0_dist outputs its messages to the file /users/modis/STORAGE/DLOG on the ingest 

server. Its size should be checked from time to time. If it exceeds 100,000 lines, follow these steps: 

 Monitor the distribution (Section 3.1.1). Wait until the distribution is done. 

 Log in to the ingest server and rename DLOG. 

 Execute the command 

kill -9 `/users/gae/sbin/get_pid l0_dist` 

 Monitor the distribution log for start-up message: 

Fri Aug 6 11:05:31 PDT 2010 Starting /users/modis/bin/l0_dist. 

Refer to document RD-04 for details. 

3.15 Problem Reporting 

Problem reporting will be done mainly by DND operators and is also described in the Operator’s Manual 

(RD-02). To report a problem, connect to IES’s implementation of the Open Technologies Real Services 

(OTRS) by starting a Web browser and entering the following location: 

https://www.iescweb.com/customer 

You will need a user name and password. Problems are reported through an intuitive Web interface. Attach 

the relevant log files, or extract thereof, to expedite the problem resolution. Immediately after it is 

completed, the operator will receive an e-mail confirmation of the reported problems. Thereafter, each 

change to the problem report is easily tracked internally at IES and by DND personnel each receiving e-mail 

updates. The ORTS manual can be accessed with the file OTRS Quick Guide for Customer Interface.pdf 

located in the latest PE-ESC Maintenance DVD. 

If the problem requires the repair of Dell equipment you will be asked to contact Dell for support.  The 

number in Canada is 1-800-387-5757. 

3.16 Remote Monitoring Session 

The implementation of the remote monitoring functionality described below requires authorization from 

DIM Secur and the configuration of the GPNet routers in order to permit the associated network traffic. 

Please contact your ISSO or ES LCMM to determine if this functionality is available for use. 

Remote monitoring is performed by Global Imaging (GI) and/or Info-Electronics (IES) technical staff. In 

order to initiate a remote monitoring session, the following steps are taken: 

1. Synchronize Session 

Usually by phone or e-mail exchange, DND operator and the vendor technician need to schedule a 

remote monitoring session and exchange password. This step makes it so the SSH tunnel remains 

open for the shortest time possible. 
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2. Creation of SSH Tunnel 

This step is performed by DND’s operator. To open a network tunnel to GI or IES, double-click on 

the “Tunnel to GI” or the “Tunnel to IES” icon respectively. A terminal window appears. The 

operator enters the password in this window. The tunnel between the operator workstation and the 

vendor site is now opened. 

Before executing this step, GI or IES sets a temporary password and gives it to the operator. 

3. Remote Monitoring 

This step is performed by the vendor technician. The technician has access to the system and can use 

that access to troubleshoot any reported problem. 

Before executing this step, DND must give the password of user seadas on the operator workstation 

to IES or GI. However, in order to keep secure passwords, the administrator may request the 

operator to set-up a temporary password for the duration of the remote monitoring session. Once the 

session is terminated, the password is reset to its original value. 

To modify the password of user seadas on the operator workstation, open a window and enter the 

command ‘passwd’. Enter a temporary password. 

4. Tunnel Termination 

This step is performed by DND’s operator. The tunnel is terminated by closing the terminal window, 

by entering exit in the terminal window or by pressing [Ctrl-C] in the terminal window. 

If a temporary password was set-up, it should be replaced with its permanent value. 
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3.17 Product Sharing 

The Product Sharing Package is installed on both servers and has been activated to transfer L2 and L3 products 

as well as exported images from the PE-ES Processing Servers to a Zone Interface Point (ZIP) server on the 

CFWOS firewall using secure copy SCP.  

The product sharing application runs on one of the processing servers, usually the primary processing server. 

The application is transferring the data to the ZIP server automatically and regularly. 

The L2 and L3 products pushed to the ZIP server are stored under the “home” directory of the ZIP user as shown 

in the table below: 

L2 (granule) “home”/MODIS-Sprod-gran-YMD-hms.hdf  

L3 (AOI) “home”/ MODIS-Sprod-area-YMD-000000.hdf  

The exportable images pushed to the ZIP server are stored under the “home” directory of the ZIP user as shown 

in the table below: 

L2 (granule) “home”/SYMDhms.gran.prod.gpp.png 

L2 (AOI) “home”/SYMDhms.area.prod.gpp.png 

L3 (AOI) “home”/SYMDhms.area.prod.gpp.png 

Refer to the Product Sharing Description document (RD-13) for details of this package. 

3.17.1 Product Sharing Monitoring  

The product sharing application logs its event messages to the file~/products-sharing/logFile.log. Check this file 

on the processing server where the application is enabled. Check whether the recent data files (within the last 

two hours) are being transferred to the ZIP server. For this you need to compare with the files on the NAS listed 

in the following tables. 

The L2 and L3 products are accessed via the folders listed in the table below. 

L2 (granule) $HOME/DATA/gran/YM/prod/MODIS-Sprod-gran-YMD-hms.hdf  

L3 (AOI) $HOME/DATA/L3/Y_ttt/prod/MODIS-Sprod-area-YMD-000000.hdf  

The exportable images are accessed via the folders listed in the table below. 

L2 (granule) $HOME/Images/gran/prod.gpp/SYMDhms.gran.prod.gpp.png 

L2 (AOI) $HOME/Images/area/prod.gpp/SYMDhms.area.prod.gpp.png 

L3 (AOI) $HOME/Images/area/prod.gpp/SYMDhms.area.prod.gpp.png 

3.17.2 Product Sharing Activation 

The scheduling of the application has already been configured during the installation and enabled on one of the 

processing servers.  In the event the application needs to be de-activated (disabled) on one processing server and 

activated on the other server, follow the instructions below. 
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To Disable the product sharing task on the cron, execute the command below as user seadas. This command is to 

be executed only on the server where the application is activated.  

~/bin/pszip_config.sh disable (this will disable the scheduled task on the crontab.) 

The command above will disable the scheduled task on the cron of user seadas. 

To Enable the product sharing task on the cron, execute the command below as user seadas.  This command is 

to be executed on the other server. 

~/bin/ pszip_config.sh enable (this will enable the scheduled task on the crontab) 

The command above will enable the scheduled task on the cron of user seadas.  

Monitor the product sharing application as described in the previous section. 
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 Operator Console 

The operator console provides the operator an interface to the MODIS SeaDAS processing: Automatic or 

manual. The operator console is displayed on the operator workstation. However, in the case of the 

automatic processing, the operator console runs on either the primary or backup processor but it is displayed 

on the operator workstation. The launch operations described below are done on the operator workstation. 

To launch the operator console running on the workstation, double-click on the “SeaDAS Manual 

Operations” icon 

 

or execute the following command 

/users/seadas/bin/sds_ops –noauto 

 

To launch the operator console running on the primary processing server, double-click on the “SeaDAS 

Primary Operations” icon 

 

or execute the following command: 

ssh seadas@ps1 “/users/seadas/bin/sds_ops –noman” 

 

To launch the operator console running on the primary processing server, double-click on the “SeaDAS 

Backup Operations” icon 

 

or execute the following command: 

ssh seadas@ps2 “/users/seadas/bin/sds_ops –noman” 

 

 

The operator console window appears. 
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Figure 4-1   Operator Console Main Window 

The window contains a menu bar and two panes. The menu bar provides a simplified and centralized 

interface to launch commands for such tasks as obtaining data, automatic and manual processing, and 

checking specific operation logs. The commands executed by the console are stored in the execution log and 

are shown on the lower pane. The menus are described in the subsequent sections. 

The upper pane displays disc space, similar to that seen in the Unix “df” command, with both local and 

remote file system usage.  The lower pane displays the execution log, which is information about the 

operator console itself, as well as any command executed from the console menu bar. 

While monitoring disk usage, the Operator Console will warn the operator if disk space on any file system 

becomes too full.  This is determined by the File System Warning Threshold percentage, as displayed at the 

top of the pane.  If any file system overflows the threshold, a warning dialog appears and the pane border 

turns red, remaining red until all file systems drop below the threshold once again. Once the file system has 

been cleaned, click Okay, the pane border will turn green. 
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Figure 4-2   Upper Pane With Pop-Up Overflow 

4.1 File Menu 

The File menu contains commands to import NASA data and archive and restore the level 0 data. 

 

Figure 4-3   File Menu 

4.1.1 Order NASA L0/L1A 

To obtain L0 or L1A data from NASA directly, select “Order NASA L0/L1A…” under the File menu.  This 

command will start up the default Web browser, and direct it to the NASA’s LAADS Web Data Order Portal.  

Select the desired products, time and locations as instructed on the LAADS Web page. After completing your 

order, you will receive an order number via e-mail.  You will need this order number to download the actual 

requested datasets. 
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Figure 4-4   LAADS NASA Data Web Site 

4.1.2 Download NASA L0/L1A 

The order may take a few hours to a few days to fulfill.  You will receive a second e-mail informing you the 

order is ready to download. At this point, select “Download NASA L0/L1A…” in the file menu. The 

following dialog appears. 
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Figure 4-5   Download Nasa Order Dialog 

Enter the order number you received via e-mail in the “Order Number:” field.  You may also select a staging 

directory, where the final downloaded data will be stored, but will typically use the default.  Once you are 

ready, click the “Run” button and your download will begin.  A terminal window appears showing the output 

of the download command. Press [Enter] when requested, the output of this command will be displayed in 

the lower pane of the console. 

4.1.3 Archive Stored L0 

In order to archive L0 data for granules, select “Archive Stored L0.”  This will pop up a dialog. 

 

Figure 4-6   Archive Stored L0 Dialog 

Enter the start date and the end date of the L0 data you wish to archive. If selected, the L0 data will be 

deleted from the global storage once the archive is done. Click Run to begin the archive. A terminal window 

appears. You will be asked to enter a blank tape or the latest primary archive tape. Once you have inserted 

the proper tape and pressed [Enter], the archive will proceed. Once the data has been archived to the primary 

offline storage, you will be asked to enter a blank tape or the latest backup archive tape. Once you have 

inserted the proper tape and pressed [Enter], the archive will proceed. Once the data has been archived to the 

backup offline storage, the stored level 0 will be deleted if you have chosen this option. Once the command 

is done, you will be prompted to press [Enter]. The output of this command will be displayed in the lower 

pane of the console. 

Every time you are prompted to enter a blank tape, the program will indicate its name: PDAnnnnn or 

BDAnnnnn. It is important to label the tape with this information. 
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4.1.4 Restore Archived L0 

This selection provides the opposite functionality from above; it restores previously archived L0 within the 

selected date range. 

 

Figure 4-7   Restore Archived L0 Dialog 

Enter the start date and the end date of the L0 data you wish to restore. Click Run to begin the archive. A 

terminal window appears. You will be asked to enter the primary or backup archive tape containing the level 

0 data to restore. Once you have inserted the proper tape and pressed [Enter], the restore will proceed. You 

may be prompted for any additional tapes. Once the command is done, you will be prompted to press 

[Enter]. The output of this command will be displayed in the lower pane of the console. 

4.1.5 Quit 

This menu selection simply exits the Operator Console program.  It will not restart unless you do so by 

executing “sds_ops” from the command line. 
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4.2 The Settings Menu 

The Settings Menu gives you access to various values used during automatic and manual processing. 

 

Figure 4-8   Settings Menu 

4.2.1 Area of Interest 

This selection allows you to edit the Area of Interest (AOI) database, select the default AOI for ingestion and 

automatic processing, and select the default AOI for the manual processing. 

 

Figure 4-9   Area of Interest Dialog 

The Main AOI dialog appears, and allows you to view all the possible Areas of Interest, as well as Add, 

Modify or Delete entries via the dialog’s “Edit List” Menu.  Deleting simply requires you to select an AOI, 

select “Delete” from the menu, and verify the deletion. 

Adding or modifying an AOI pops up an “Edit AOI” Dialog that allows you to enter or change values. 
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Figure 4-10   Edit Area of Interest Dialog 

 

When adding or modifying an AOI, you must set all the fields within correct ranges. 

The “Name” field must be a unique name.  This name functions as an argument to the manual processing 

when you use the “-aoi <name>” switch from the command line. 

The “Tag” field identifies which AOI is used by default during automatic or manual processing.  Only one 

AOI can be flagged as “Manual” (default for manual processing), and only one can be flagged as “Default 

(Automatic)” (default for automatic processing).  Typically you will select “None” meaning the AOI can 

only be specified from the command line during manual processing. 

The Top, Left, Bottom, and Right define the boundaries of the AOI in Latitude/Longitude in using fractional 

degrees. 

Once you are satisfied with your new AOI, click the “Okay” button.  Otherwise you can click “Cancel” and 

any changes you made are ignored and abandoned. 

In the Main Dialog, you also have the option of accepting changes with the “Save” button, or abandoning 

them with the “Cancel” button. 

If the AOI tagged as default is modified and saved to the AOI database file, it must be distributed to 

all the machines on the system with the command sds_ops_propagate_aoi executed in a local terminal 

window. 
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4.2.2 Automatic Processing Settings 

This selection opens up the “modismgr” interface to access the automatic processing database. 

 

Figure 4-11   MODIS Manager Interface (Automatic Processing) 

Note that the Storage column is on for the automatic processing and should stay on. This interface is used 

ONLY to prevent the generation of certain products. For example, the SST (L2, L2B, and L3) generation can 

be prevented by selected MODL2SST and selecting ‘Modify MOD…’ in the Edit menu. Once the dialog 

appears, set the execution to ‘off’ and click Okay. The execution status of MODL2SST is ‘off’ and the 

execution status of MODL2BSST, MODL3DSST, and MODL3RSST is ‘idle’. Save your modification with 

FileSave. From this moment, the SST products will not be generated. Any changes to the automatic 

processing database should be done on the primary and backup processing servers. The MODIS Manager 

program is described in documents RD-05 and RD-06. 
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4.2.3 Manual Processing Settings 

This selection opens up the “modismgr” interface to access the manual processing database. 

 

Figure 4-12   MODIS Manager Interface (Manual Processing) 

Note that the Storage column is off for the automatic processing. This interface is used ONLY to prevent the 

generation of certain products. For example, the SST (L2, L2B, and L3) generation can be prevented by 

selected MODL2SST and selecting ‘Modify MOD…’ in the Edit menu. Once the dialog appears, set the 

execution to ‘off’ and click Okay. The execution status of MODL2SST is ‘off’ and the execution status of 

MODL2BSST, MODL3DSST, and MODL3RSST is ‘idle’. Save your modification with FileSave. From 

this moment, the SST products will not be generated. The MODIS Manager program is described in 

documents RD-05 and RD-06. 
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4.3 Automatic Processing Submenu 

The Processing Menu is made up of two primary submenus, giving you easy access to various manual and 

automatic processing commands.  This section covers the automatic processing submenu, which allows you 

to choose the downloaded data to submit for automated processing. 

 

Figure 4-13   Automatic Processing Menu 

4.3.1 Submit External L0 or L1A to Automatic Processing 

The Submit External L0 and L1A pops up a dialog box, shown below, which allows you to select datasets, 

and a “Run” button to submit the selected datasets to the input queue of the automatic processing. 

 

Figure 4-14   Submit External Datasets Dialog 
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In order to add datasets, select “Add” in the “Datasets” menu.  The “Add” dialog, shown below, allows you 

to select datasets obtained from the pre-determined L0 (or L1A) pattern in the staging directory. 

 

Figure 4-15   Add Datasets Dialog 

You simply select one or more datasets from the provided list and click “Okay.”  You can add as many 

datasets as you would like, depending on availability. 

The “Fill With All Datasets” selection in the “Dataset” menu of the primary dialog will automatically select 

all datasets in the staging directory that match the pre-defined pattern.  This is a quick way to add all the 

requisite datasets.  You can also select a dataset and choose “Delete” from the menu if you do not want it 

processed. 

After you have selected at least one dataset, click “Run” in the Submit External L0/L1A Dialog, and your 

datasets will be submitted for automatic processing. 

4.3.2 Monitor Automatic Processing 

This menu item is simply a shortcut to monitor the automatic processing log.  It executed the script 

sds_ops_monitor_auto_proc which starts the Log Browser, to monitor the log associated with the automatic 

processing. 
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4.4 Manual Processing Submenu 

Manual Processing is the second submenu appearing in the Processing Menu.  This menu provides access to 

commands for processing granules and monitoring progress. 

 

Figure 4-16   Manual Processing Menu 

The Manual Processing submenus differ greatly from the automatic processing submenu because they allow 

processing to begin at multiple levels (L0, L1A, L1B, or L2) and multiple sources (External, Local, and 

Local & Stored) while automatic processing limits you to submit L0 or L1A from an external source. 

4.4.1 Process External L0/L1A Submenu 

This submenu allows you to manually process downloaded L0 or L1A data from an external source. The 

interface is the same for either type of data. 

 

Figure 4-17   Process External Datasets Dialog 
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You can choose whether or not to process all the way to Level 3.  The “Process L3 Data” toggle allows you 

to select whether or not to do so.  If you do choose to process to L3, you also need to select an L3 resolution 

from the corresponding “L3 Resolution” menu. 

Because this is manual processing, the Area of Interest flagged as “manual” in the AOI database will be 

chosen by default.  You can, however, select a different AOI using the “Area of Interest” menu. 

You can select all the datasets with the function “Fill with all Datasets” in the Datasets menu. Or you can 

add selected datasets to the list with the function Add in the Datasets menu. The following dialog appears. 

 

Figure 4-18   Add Datasets Dialog (External Data) 

Highlight one or more datasets and click Okay. 

Click “Run” to execute the command to immediately process the chosen L0 or L1A data. Refer to the Logs 

menu below to monitor the processing. 
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4.4.2 Process Local L0/L1A/L1B Submenu 

This submenu allows you to manually process L0, L1A, or L1B data stored locally. The interface is the same 

for all types of data. 

 

Figure 4-19   Process Local Datasets Dialog 

You can choose whether or not to process all the way to Level 3.  The “Process L3 Data” toggle allows you 

to select whether or not to do so.  If you do choose to process to L3, you also need to select an L3 resolution 

from the corresponding “L3 Resolution” menu. 

Because this is manual processing, the Area of Interest flagged as “manual” in the AOI database will be 

chosen by default.  You can, however, select a different AOI using the “Area of Interest” menu. 

If you wish to process one or more consecutive days, enter the start date and the end date of the period and 

select the function “Fill With Datasets Between Start/End Dates…”.in the Datasets menu. You can select all 

the datasets with the function “Fill with all Datasets” in the Datasets menu. Or you can add selected datasets 

to the list with the function Add in the Datasets menu. The following dialog appears. 
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Figure 4-20   Add Datasets Dialog (Local Data) 

Highlight one or more datasets and click Okay. 

Click “Run” to execute the command to immediately process the chosen L0, L1A, or L1B data. Refer to the 

Logs menu below to monitor the processing. 

4.4.3 Process Local & Stored L0/L1A/L1B Submenu 

This submenu allows you to manually process L0, L1A, or L1B data stored locally and globally. The 

interface is the same for all types of data. 

 

Figure 4-21   Process Local & Stored Datasets Dialog 
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You can choose whether or not to process all the way to Level 3.  The “Process L3 Data” toggle allows you 

to select whether or not to do so.  If you do choose to process to L3, you also need to select an L3 resolution 

from the corresponding “L3 Resolution” menu. 

Because this is manual processing, the Area of Interest flagged as “manual” in the AOI database will be 

chosen by default.  You can, however, select a different AOI using the “Area of Interest” menu. 

Enter the start date and the end date of the period you wish to process. Click “Run” to execute the command 

to immediately process the L0, L1A, or L1B data for the given period. Refer to the Logs menu below to 

monitor the processing. 

Note that the L0, L1A, or L1B datasets stored globally for the requested period will be restored locally 

before the processing takes place. 

4.4.4 Process L2 Submenu 

This submenu allows you to manually process L2 data stored locally or L2 data stored locally & globally. 

The interface is the same for both sources. 

 

Figure 4-22   Process L2 Datasets Dialog 

Select an L3 resolution from the corresponding “L3 Resolution” menu. 

Because this is manual processing, the Area of Interest flagged as “manual” in the AOI database will be 

chosen by default.  You can, however, select a different AOI using the “Area of Interest” menu. 

Enter the start date and the end date of the period you wish to process. Click “Run” to execute the command 

to immediately process the chosen L0, L1A, or L1B data. Refer to the Logs menu below to monitor the 

processing. 

If you are running the “Stored & Local” function, the L2 datasets stored globally for the requested period 

will be restored locally before the processing takes place. 
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4.5 Logs 

The automatic or manual processing generates a log file containing the start and end messages of a granule 

processing and the start and end messages of the time (daily) processing as well as other relevant processing 

messages. Each granule processing generates a log file and each time processing generates a log file. 

The automatic processing generates three categories of processing logs: 

 Automatic Processing Log  /users/seadas/PLOG_auto 

 Automatic Granule Processing Logs /users/seadas/data/auto_gran/YMDhms.sid.log 

 Automatic Temporal Processing Logs /users/seadas/data/auto_time/YMD.log 

The manual processing generates three categories of processing logs: 

 Manual Processing Log   /users/seadas/PLOG_man 

 Manual Granule Processing Logs /users/seadas/data/man_gran/YMDhms.sid.log 

 Manual Temporal Processing Logs /users/seadas/data/man_time/YMD.log 

The Logs menu allows you to browse or monitor various processing logs for the automatic processing and 

the manual processing with these two submenus. 

 

Figure 4-23   Automatic Processing Logs Menu 

 

 

Figure 4-24   Manual Processing Logs Menu 

 

Both submenus are divided into two types of Log viewing.  You can browse a log, or you can monitor a log.  

The difference being that browsing a log starts the log viewer with a blank screen, and you must manually 

select a specific log to display.  When monitoring a log, the viewer opens up with the specific log already 

chosen, and begins displaying it immediately.  You cannot choose a different log in monitor mode, though it 

will cycle to newer logs created during processing. 
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4.5.1 Browse Automatic/Manual Log 

This section applies to the browsing of any category of automatic or manual processing logs. The image 

below shows the xlog_browse interface when “Browse Granule Logs” is selected in the “Automatic 

Processing” submenu. After the interface appears, you must use the “File->Open” menu selection in order to 

choose the specific log file to view. 

 

Figure 4-25   Browse Log – Choosing a Log to View 

Once you have made a selection, the file is loaded and can be browsed. You can use the scroll bars to look at 

different portions of the log.  You can also “Open” another log for viewing at any time. 
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Figure 4-26   Browse Log – Viewing the Log 
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4.5.2 Monitor Automatic/Manual Log 

This section applies to the monitoring of any category of automatic or manual processing logs. The image 

below shows the xlog_browse interface when “Monitor Processing Logs” is selected in the “Manual 

Processing” submenu. 

 

Figure 4-27   Monitor Log (Manual Processing) 

When monitoring multiple logs (granule or time logs), newer log files are displayed on the window. The 

window is continuously updated as new lines are added to the currently monitored log file.  

You can select “Stop” or “Start” from the “File” menu to pause and restart the monitoring, but otherwise you 

are restricted to monitoring the specific log chosen (processing, granule or time). 
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 Troubleshooting 

The primary troubleshooting is done by the operator upon observation of a problem. The first type of problems 

concerns the tracking, the ingestion, the distribution, or the automatic or manual processing chain. These 

problems will be observed by an absence of products or with specific messages in the tracking, ingestion, 

distribution, or processing logs.  

The second type of problems concerns the access to a remote computer on the system and the download of the 

orbital elements. These problems are detected by the system alerts software running on the operator workstation. 

The third type of problems relates to the Operating System, the daemons, or drivers running in the background. 

These problems may cause a disruption with the tracking, ingestion, distribution, or processing chain. Once 

diagnosed by IES personnel, Red Hat support will be contacted if needed. 

The fourth type of problems relates to hardware malfunction or failure.  Once diagnosed by IES personnel, Dell 

support will be contacted if Dell hardware is involved.  Otherwise, the spare carried by DND will be used to 

allow the repair of the defective hardware. 

The sections below describe the troubleshooting tips for the tracking and ingestion (5.1), the distribution (5.2), 

the automatic and manual processing chains (5.3 and 5.4), the Level tape operations (5.5), the system alerts 

(5.6), and the orbital elements alert (5.7).  Section 5.8 and 5.9 shows the operator how to upload the 

tracking/ingestion logs and processing logs respectively to the GI FTP site. 

Throughout this section, consult Section 3.15 when asked to submit a problem report. 

5.1  Tracking and Ingestion 

 Override Lock File pop-up window appears at start of STracker 

If STracker+ is already running or its lock file is present, the following pop-up window appears 

 

In this case, click No. Open a terminal window and verify that STracker+ is running or not with the 

command 

ps –ef | grep stracker | grep java 

If nothing is output by the command, start STracker+ again and click Yes when requested. 

If a line such as 

satops   22850 22849 … /usr/java/jdk1.5.0_06/bin/java … 

appears, STracker+ is already running. It is possible that the STracker+ window is iconized.  Look at the 

bottom of the VNC-IVS window for its icon.  If the icon cannot be found, terminate the current 

STracker+ with the command 

kill -9 <pid> 

where <pid> is the number shown in the second column (22850) of the ‘ps –ef …’ command. Start 

STracker+ again and click Yes when requested. 
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If more than one line such as 

satops   xxxxx yyyyy … /usr/java/jdk1.5.0_06/bin/java … 

appears, terminate every instance of STracker+.  Start STracker+ again and click Yes when requested. 

 Initialization Warning pop-up window appears at start of STracker 

If there is an error starting STracker+, the following pop-up window appears 

 

The splash screen behind this pop-up window indicates which sub-system has a problem 

 

Ckick OK. The SAT, ANT, or the ACQ status windows will be in error mode. 

 

Check below for the particular event.  If it cannot be found, check for error messages in the STracker log 

file and submit a problem report. 

 SAT Status window blink red (STracker+) 

The background of the SAT status window blinks red when the orbital elements used by STracker+ are 

older than the given threshold (default is 5 days).  A message such as the following is output to the 

STracker+ daily log: 

Elements for ???? are 6.84 days old. SAT: status panel box will blink red. 

 

In this case, execute these steps: 

o Verify elements update settings with “STracker+SetupOrbital Elements” : 

 Check that “Internet Location” is set to /users/gae/oestools/tle.txt. If not, set it to the 

correct value. 
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 Check that “Update interval” is set to 1”. If not, set it to the correct value. 

o Update the elements with “STracker+Orbital ElementsUpdate from Internet”. 

o If the SAT status window is still blinking red, check the downloaded orbital elements on the 

ingest server (Section 8.2 in document RD-02). 

 ANT Status window shows red (STracker+) 

The background of the ANT status window shows red when there is a problem communicating or 

controlling the antenna.  In this case, perform the following steps: 

o Re-start STracker+ and point the antenna to any position or track the SUN. If the problem 

persists, execute the next step. 

o Stop STracker+ and instruct the technician at the remote site to cycle the power to the antenna 

by opening and closing the radome hatch. Once the power has been cycled, start STracker+ and 

point the antenna to any position or track the SUN. If the problem persists, execute the next step 

o If message in the STracker+ log is  

<message>, check if controller is powered/connected. 

Refer to “Checking the Antenna Controller Chain” in document RD-02. 

o If message in the STracker+ log is 

Incorrect number of prompts, -2 instead of <n> 

<AZ|EL>CMD: <command> 

<AZ|EL>RET: 

Refer to “Checking the Antenna Controller Chain” in document RD-02. 

o If message in the STracker+ log is 

Incorrect number of prompts, <k> instead of <n> 

<AZ|EL>CMD: <command> 

<AZ|EL>RET: <answer> 

Refer to “Checking the Antenna Controller Chain” in document RD-02. 

o For any other messages, submit a problem report with your findings and consult Section 5.8 to 

upload the latest STracker logs. 

 ANT Status window shows yellow (STracker+) 

The background of the ANT status window shows yellow when there was a problem communicating 

with or controlling the antenna when STracker started. In such instance, the ANT status window shows 

red until tracking the end of the first pass at which time the ANT status window switches to yellow to 

indicate it is tracking in simulation mode.  Re-start STracker+.  If the ANT status window shows red, 

proceed with the following: 

o If message in the STracker+ log is  

<message>, check if controller is powered/connected. 

Refer to “Checking the Antenna Controller Chain” in document RD-02. 

o If message in the STracker+ log is 
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Incorrect number of prompts, -2 instead of <n> 

<AZ|EL>CMD: <command> 

<AZ|EL>RET: 

Refer to “Checking the Antenna Controller Chain” in document RD-02. 

o If message in the STracker+ log is 

Incorrect number of prompts, <k> instead of <n> 

<AZ|EL>CMD: <command> 

<AZ|EL>RET: <answer> 

Refer to “Checking the Antenna Controller Chain” in document RD-02. 

o For any other messages, submit a problem report with your findings and consult Section 5.8 to 

upload the latest STracker logs and ingest logs. 

 ACQ Status Window shows “See Log Panel” (STracker+) 

o If message in the STracker+ log is 

The feed is not seen by the receiver 

Refer to “Checking the IF Chain” in document RD-02. 

o If message in the STracker+ log is 

X-Band, receiver/usb, command <command>, only 0 char. returned. 

Stop Stracker+, check USB cable connection to the receiver, cycle the power on the receiver, 

and start STracker+. If the problem persists, submit a problem report. 

o If message in the STracker+ log is 

X-Band, receiver/usb, command <command>, only <n> char. returned. 

This error may occur occasionally.  You may ignore this problem. If the message occurs 

continuously, stop STracker+, check USB cable connection to the receiver, cycle the power on 

the receiver, and start STracker+.  If the problem persists, submit a problem report. 

o For any other messages, submit a problem report with your findings and consult Section 5.8 to 

upload the latest STracker logs and ingest logs. 

 No picture in Quick View 

o Exit current Quick View and start a new Quick View. 

o If error messages in STracker+ log, submit a problem report. 

o If error messages in the ingest logs, submit a problem report. 

o Check if old orbital elements for the satellites. 

o Check ingest server clock (see “Clock Synchronization” in document RD-02). 

During a pass: 

o Monitor the receiver and ingestion (Section 3.1.1). The receiver lock, bit sync, and frame sync 

indicators should be green. 

o Monitor the antenna (Section 3.1.1). The antenna pointing angles should be the same as the 

satellite look angles. 
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o Submit a problem report with your findings and consult Section 5.8 to upload the latest STracker 

logs and ingest logs. 

5.2 Checking the Level 0 Distribution 

Refer to Section 3.1.1 to monitor the distribution log.  The following message appears for each acquired 

pass where a Level 0 dataset is generated: 

Wed Dec 30 14:05:21 PST 2015 SCPing 20151230215232.epm1.ndx to seadas@ps1 

Wed Dec 30 14:05:21 PST 2015 SCPing 20151230215232.epm1.gbd to seadas@ps1 

Wed Dec 30 14:05:21 PST 2015 SCPing 20151230215232.epm1.l0u to seadas@ps1 

Wed Dec 30 14:07:12 PST 2015 SCPing done. 

If no such message is shown for the latest pass or passes, follow these steps. 

 The following message in the distribution log indicates a problem with SCP access to the destination 

host: 

o ssh: connect to host <host> port 22: No route to host 

In this case, contact the system or network administrator. 

 The following messages in the distribution log indicate a problem with the l0_dist script configuration or 

with password less access: 

o ssh: <name>: Name or service not known 

o Permission denied, please try again. 

In this case, request that the system administrator 

o Verify that the script, /users/modis/bin/l0_dist, has the correct host names and the user name is 

seadas for both destinations. 

o Verify that the host names are in /etc/hosts have the correct IP address. 

o Verify that user seadas on the primary and backup MODIS processors has been configured to 

allow password less access by user modis of the ingest server. 

o Verify that /users/seadas/level0 directory exists on both MODIS processors. 

 Open a terminal window and verify l0_dist is running 

ps –ef | grep l0_dist | grep csh 

If l0_dist is running, a line such as this is output 

modis 3390 3389 0 14:28 ? 00:00:00 /bin/csh /users/modis/bin/l0_dist 

If no such line is shown, refer to Section 5.6.2 in document RD-02 for details on starting the level 0 

distribution. 

 Check the STracker log for errors and submit a problem report if any. 

 Check the ingestion logs for errors and submit a problem report if any. 

 Check the ingestion logs and verify that packets have been generated: 

681921 CCSDS packets extracted from telemetry. 

If no packets were generated, submit a problem report. 

 Check the ingestion logs and verify the Level 0 dataset is generated: 

/users/modis/pass/epm1/15364215232: 564869 CADU blocks read. 

cadu(564869)=good(495564)+     …       ==>681920 packets. 

20151230215232.epm1.l0ux: 681920 packets written. 
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START:    21182   78750085 73 

END  :    21182   79494549 919 

20151230215232.epm1.ndxx: created. 

If no packets were written, submit a problem report. 

 For any other message, submit a problem report. 

5.3 Automatic Processing Chain 

The automatic processing chain takes place on the primary or backup processor. A problem with the processing 

will manifest itself with the following events: 

 Absence of exportable images in /users/seadas/Images for the latest pass(es). 

Verify that /nas0 is mounted on the MODIS processors and the operator workstation. If not, ask the 

system administrator to mount it and wait until the next pass. If after the next pass there is no exportable 

data, submit a problem report and consult Section 5.9 to upload the processing logs. 

 Absence of global (stored) products in /users/seadas/DATA for the latest pass(es). 

Verify that /nas1 is mounted on the MODIS processors and the operator workstation. If not, ask the 

system administrator to mount it and wait until the next pass. If there is still no global data after the next 

pass, submit a problem report and consult Section 5.9 to upload the processing logs. 

 Absence of local products in /users/seadas/data for the latest pass. 

In this case, submit a problem report and consult Section 5.9 to upload the processing logs. 

 The MODIS processing log does not show the arrival of the level 0 data after a pass has been ingested. 

In this case, refer to Section 5.2 above to verify the distribution. 

 Skip the remaining steps if not ordering data for processing on one of the processing servers. 

 Problem with ordering NASA data. 

Try again. If problem persists, contact the network administrator. 

 Skip the remaining steps if no data was ordered from NASA. 

 Problem with downloading ordered NASA data. 

o If the download hangs because of Internet communication problems, try again. If the problem 

persists, contact the network administrator. 

o If there are errors showing in the download terminal window, submit a problem report.   

 Absence of downloaded data in /users/seadas/staging of the primary processor. 

o Verify that the operator console you are using is running on the primary processor. 

The hostname of the primary processor will be the title of the operator console window. 

o If the data is in /users/seadas/staging of the backup processor, use its operator console to submit 

for processing. 

o If the data is in /users/seadas/staging of the operator workstation, move it to the primary 

processor and submit it. 

 Absence of downloaded data in /users/seadas/staging of the backup processor. 

o Verify that the operator console you are using is running on the backup processor. 
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The hostname of the backup processor will be the title of the operator console window. 

o If the data is in /users/seadas/staging of the primary processor, use its operator console to submit 

for processing. 

o If the data is in /users/seadas/staging of the operator workstation, move it to the processor and 

submit it. 

5.4 Manual Processing Chain 

The manual processing chain takes place on the operator workstation. A problem with the processing will 

manifest itself with the following events: 

 Absence of global (stored) products in /users/seadas/DATA for the latest pass(es). 

Verify that /nas1 is mounted on the operator workstation. If not, ask the system administrator to mount it 

and try again. If there is still no data, submit a problem report and consult Section 5.9 to upload the 

processing logs. 

 Absence of local products in /users/seadas/data of the operator workstation. 

In this case, submit a problem report and consult Section 5.9 to upload the processing logs. 

 Problem with ordering NASA data. 

Try again. If problem persists, contact the network administrator. 

 Problem with downloading ordered NASA data. 

o If the download hangs because of Internet communication problems, try again. If the problem 

persists, contact the network administrator. 

o If there are errors showing in the download terminal window, submit a problem report.   

 Absence of downloaded NASA data in /users/seadas/staging of the operator workstation. 

o Verify that the operator console you are using is running on the operator workstation. 

The hostname of the backup processor will be the title of the operator console window. 

o If the data is in /users/seadas/staging of one of the MODIS processors, move it to the operator 

workstation and process it. 

5.5 Level 0 Tape Archive/Restore 

Before submitting a problem report, check the following: 

o Verify that the operator console you are using is running on the backup MODIS processor. 

o Verify that the device file /dev/st0 exists and that it has read/write permission. 

ls –l /dev/st0 

The permission should be ‘crw-rw-rw-‘. If the device does not exist or the permission is incorrect, 

contact the system administrator. 

o Verify that /nas1 is mounted on the operator workstation. If not, ask the system administrator to mount 

it. 

o Verify that /nas1/MP_DB/ exists. If not submit a problem report. 

If everything checks out and you still have problems, submit a problem report. 
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5.6 System Alert 

The system alert messages are output by the script sds_ops_system_alert running as a cron job of user seadas on 

the operator workstation. These messages are logged in the file /users/seadas/alert.log on the operator 

workstation and are shown in a pop-up window. 

 
Figure 5-1   System Alert xmessage 

Inform the administrator of the message shown in the pop-up window or consult Section 8.1 in Maintenance 

Manual (RD-02) for troubleshooting tips. 

5.7 Orbital Elements Alert 

The orbital elements are downloaded daily from a NASA FTP site with the script get_oes running as a cron job 

of user gae. The output of the cron job is reported in the mail file /var/mail/gae on the computer running get_oes.  

If there is a download failure, an error message is shown in a pop-up window. 

 

Figure 5-2   Orbital Elements Download xmessage 

In the message above, wows indicate the west site operator workstation as the computer generating the message. 

It is followed by the script name and the message itself. Inform the system administrator of the message or 

consult Section 8.2 in the Maintenance Manual (RD-02) for troubleshooting tips. 

5.8 Upload STracker and Ingest Logs to GI FTP Site 

When a problem with STracker or the ingestion occurs, the access by Global Imaging personnel to the relevant 

logs is crucial to diagnose the problem.  The latest STracker log and ingestion log files on the Ingest server can 

be uploaded to Global Imaging’s FTP site with the script ftp_sat_info as shown below. 

To manually upload the satellite information of the last 7 days, login as user modis on the Ingest server and 

execute the following command: 

/users/gae/sbin/ftp_sat_info <user> <password> 7 

where <user> and <password> are the FTP user name and password to your GI FTP account. 
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To avoid typing the user name and password, log in as user gae on the Ingest server, edit ftp_sat_info, and insert 

the name and password in the following lines: 

set ruser="" 

set rpass="" 

The modified script is executed as follows: 

/users/gae/sbin/ftp_sat_info 7 

Note that this procedure must be done every time ftp_sat_info is updated via a GI patch. 

To automatically upload the satellite information every day, log in as user modis on the Ingest server, execute the 

command ‘crontab –e’, add the following command to the cron jobs of user modis: 

55 <hh> * * * /users/gae/sbin/ftp_sat_info 2 

and replace <hh> with the local hour corresponding to 23 UTC to execute slightly before the end of the UTC 

day. 

5.9  Upload SeaDAS Processing Logs to GI FTP site 

When a problem with the SeaDAS processing occurs, the access by Global Imaging personnel to the relevant 

logs is crucial to diagnose the problem.  The latest processing log files on the Operator workstation or one of the 

Processing servers can be uploaded to Global Imaging’s FTP site with the script ftp_seadas_info as shown 

below. 

To manually upload the processing information, login as user seadas on the appropriate machine and execute the 

following command: 

/users/seadas/bin/ftp_seadas_info <user> <password> 

where <user> and <password> are the FTP user name and password to your GI FTP account. 

To avoid typing the user name and password, log in as user gae on the appropriate machine, edit 

ftp_seadas_info, and insert the name and password in the following lines: 

set ruser="" 

set rpass="" 

The modified script is executed as follows: 

/users/seadas/bin/ftp_seadas_info 

Note that this procedure must be done every time ftp_seadas_info is updated via a GI patch. 
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A.  Acronyms and Abbreviations 

AD Applicable Document 

AOI Area of Interest 

ASCII  American Standard Code for Information Interchange 

  

CADU Channel Access Data Unit 

CF Canadian Forces 

CFB Canadian Forces Base 

CFWOS Canadian Forces Weather and Oceanographic Services 

CCSDS Consultative Committee for Space Data Systems 

  

DB Direct Broadcast 

DND Department of the National Defence 

  

EOS Earth Observing Satellite 

ES Environmental Sensing 

ESC Environmental Sensing Capability 

  

GI Global Imaging 

GMT Greenwich Mean Time  

GUI Graphical User Interface 

  

ICD Interfaces Control Document 

IES Info-Electronics Systems Inc. 

IVS Ingest Virtual Screen 

  

MetOC Meteorological and Oceanographic Centre 

MODIS Moderate Resolution Imaging Spectroradiometer 

  

NAS Network Attached Storage 

NASA National Aeronautics and Space Administration 

NOAA National Oceanic and Atmospheric Administration 

NPOES National Polar-orbiting Operational Environmental Satellite System 

NPP NPOES Preparatory Project 

NSOF NOAA Satellite Operation Facility 

  

OC Ocean Color 

OCP Ocean Color Products 

OTRS Open Technologies Real Services 
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PDU Power Distribution Unit 

  

RD Reference Document 

RHEL Red Hat Enterprise Linux 

  

SCID Spacecraft ID 

SeaDAS SeaWIFS Data Analysis System 

SeaWIFS Sea-viewing Wide Field-of-view Sensor 

SSH Secure Shell Handler 

SST Sea Surface Temperature 

  

TBC To Be Confirmed 

TBD To Be Determined 

TDP Technical Data Package 

  

UMS Universal Multi-Satellite 

UPS Uninterruptible Power Supply 

UTC Universal Time Coordinated 

  

VNC Virtual Network Computing 

VSS Vendor Supplied System 

VCDU Virtual Channel Data Unit 

VCID Virtual Channel ID 

  

ZIP Zone Interface Point 

 


